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1. Introduction

1.1. Overview

USR-M100-ARD is an open source |oT gateway powered by Espressif’'s ESP32 module equipped with low
power Xtensa® 32-bit LX6 MCU 240 MHz processor with 4MB pSRAM and up to 8MB SPI flash memory on-board. It
integrates rich hardware interface: R5485/232, DO*2, DI*1, Al*1, downloading port, Wi-Fi, Ethernet port and BLE.
PUSR provides basic source code demo for users to develop their own application. For the rich hardware
interface and networking methods, this device can be applied in a variety of scenarios, especially scenarios
where users need to collect or control serial devices and |0 devices simultaneously, such as: Wastewater

Treatment, Agricultural Irrigation, Solar Energy, Intelligent Farming etc.

1.2. Parameters table

USR-M100-ARD Parameters

Chipset ESP32-WROVER-E

Professor Dual-core Xtensa® 32-bit LX6 MCU, 1.2GHz
RAM 8M

Flash aM

Power Supply 9~36V
Hardware Interface

R5232/485 1*R5232/485,

Default parameter: 115200, N, 8, 1
DI 1*digital input
DO 2*digital output
Al 1*analog input(4~20mA)
Wi-Fi
Stadard IEEE802.11b/g/n
Speed Up to 150Mbps
Frequency 2412 ~ 2484 MHz
Others
BLE Compatible with BEL4.2

Table 1. Parameters of USR-M100-ARD

USR-M100-ARD provides 2 indicators in total, the specific description is as follows.

Table 2. LED indicator

Name Description
PWR Steady on: power supply is normal.

Off: No power supply or abnormal power supply.
WORK Steady on: The system works normally.
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1.3. Dimension

» DIN-Rail mounting and wall mounting supported.

» 79.6%58*110.0mm (L*W*H, accessories not included)
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Figure 1. Dimension of USR-M100-ARD

2. Arduino IDE Using

1> Download and install Arduino IDE: https://www.arduino.cc/en/Main/Software
2> After installing the IDE, add additional boards manager URLs:
https://dl.espressif.com/dl/package_esp32_index.json

File->Preference-> Add Additional Boards Manager URLs

PUSR’
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Arduino 1

File Edit Sketch Tools Help

0911m100ckv1

X
T LTI EEI T LETTE 1T /100 sample
Settings Network
“define PHYTESTSANPLE_ENABLE hetehbock Tocation:
ine VEBserverSAMPLE_ENABLE ;
ine MODBUSTESTSAMPLE_ENABLE D:\STE\rduine Brovse

ine FEEDDOGENABLE Editer language: English (English) v (requires restart of Arduine)
fine AWS_CLOUD_ENABLE

Editor font size: 12

Interface scale: Automatic 100 2%  (requires restart of Arduino)

Show verbose output during: [Z]conpilation [Juplead
Conpiler warnings: None

[Ipisplay line numbers

sinclude <WebServer.h> [JEnable Code Folding
#include <ESPmDNS.h>

Verify code after upload
[Juse external editor

onst char ssid = “songhuimobile”;

const char* password = "13918134855"

Aggressively cache compiled core

Check for updates on startup

4ifdef  AVS_CLOUD_ENABLE Update sketch files to nev extension on save (.pde —> .ino)

<ATS_10T.h> Save when verifying or uploading

Additional Boards Manager URLs: |https://dl. espressif. con/dl/package_es5p32_index. json (i |
efine CUST_SSID "songhuimobile” - - - -

More preferences can be edited directly in the file

ine CUST_ROUTER_PASS "13918134855"

ine CUST_BROKER “awwisOu7zuagf.ats. iot. cn-northy
ine CUST_CLOUD_CLIENT_ID "1234" (edit only
ine CUST_MQTTPUBLISHTOPIC “arduino_m100”

char HOST_ADDRESS[]=CUST_BROKER;

char CLIENT_ID[]= CUST_CLOUD_CLIENT_ID;

C:\Users\Administrator\dppData\Local \Arduinol5\preferences. txt

hen Arduino is not rumning)

0K Cancel

Uit 4MB with Spiffs (1.2VB ARPI1 5M

3> Install ESP32 Boards

Tools->Board Manager->Search “ESP”

File Edit Skef}

0911m100ckv1

TELELLEAITELTEII R EA AL TFE] 171 m100  sample config  begin//////[/1TEITEITIZLELITELIEDIERLEZETELTEDIE

X
efine PHYTESTSANPLE_ENABLE 2'
ine WEBserverSAMPLE_ENABLE Type [a11
ins WODBUSTESTSAMPLE_ENABLE
e Arduino AVR Boards by Arduino version 1.8.6 INSTALLED ~
+ine FEEDDOGENABLE Boards induded in this package:
ine AWS_CLOUD_ENABLE Arduino Yin, Arduino UNO, Arduino UNO Mini, Arduino UNO WiFi, Arduino Diecimila, Arduino Nano, Arduino Mega, Arduino Mega ADK, Arduino
Leonardo, Arduino Leonardo Ethernet, Arduino Micro, Arduino Esplora, Arduino Mini, Arduino Ethernet, Arduino Fio, Arduino BT, Arduino LilyPad
USB, Arduino LilyPad, Arduino Pro, Arduino ATMegaNG, Arduino Robot Control, Arduino Robot Motor, Arduine Gemma, Adafruit Circuit Playground,
Arduino Yin Mini, Arduino Industrial 101, Linino One.
Online help.
More info
#include <WiFi.h>
<WiFiClient.h> Arduino ESP32 Boards by Arduino
(TebServer. h> Boards included in this package:
Arduino Nano ESP32.
<ESPaDNS. h> More info
const char# ssid = "songhuinebile”;
const chark password = "13918134855" 4 ‘esp32 by Espressif Systems version 2.0.10 INSTALLED
Boards included in this package:
ESP32 Dev Board, ESP32-52 Dev Board, ESP32-53 Dev Board, ESP32-C3 Dev Board.
#ifdef  AWS_CLOUD_ENABLE More info
#include <AVS_IOT.h>
ine CUST_SSID “songhuimobile” o
ine CUST_ROUTER_PASS "13918134855"

ine CUST_BROKER “awvisOu7zuagf.ats.iot. crnorth-1. amai Close
ine CUST_CLOUD_CLIENT_ID "1234"

#define CUST_MQTTPUBLISHTOPIC “arduino_m100”

char HOST_ADDRESS[]=CUST_BROKER;

char CLIENT_ID[]= CUST_CLOUD_CLIENT_ID;

4> Add library to installation path

PUSR offers library source code of AWS, Modbus, users can download from Github: IHEARTEERE

PUSR pusr.com
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The downloaded libraries should be copied to the installation path of Arduino IDE.
Note: Users are strongly encouraged to use the AWS and Modbus libraries we provide.

Users can also download the other libraries needed on Arduino IDE.

Sketch->Library Manager->Search " Modbus” ->Install

0911m1000kv1

KT T1 111100 sanple  config  begin//////1IIIIAITEIEFIIEAIIIITETFIIEELIILTE]

=define PHYTESTSAMPLE_ENABLE 2 -
fine WEBserverSANPLE_ENABLE Type ALl | Topic A1l 3
fine MODBUSTESTSAMPLE_ENABLE
define ArduinoModbus by Arduino Version 1.0.8 INSTALLED A
Fdefine FEEDDOGENABLE Use Modbus equipment with your Arduino. Using TCP or RS485 shields, like the MKR 485 Shield. This library depends on the ArduinoRS485
=define AWS_CLOUD_ENABLE library.
More info
AceCRC by Brian T. Park
Cyclic Redundancy Check (CRC) algorithms: cre8, crel6ccitt, cre16modbus, cre32. Programmatically converted from C99 code generated by
WiFi.h> https://pycrc.org to Arduino C++. For each CRC algorithm, 4 variants are available: The 'bit’ variant uses brute force bit-by-bit loop (smallest and
S slowest); the nibble’ variant uses a 4-bit table (potentially good balance between size and speed); nibblem’ variant is the same as "nibble”
FiClient.h> but 1.9X-2.7X faster on the ESP8266; and the 'byte’ variant uses an 8-bit table (largest but fastest).
VebServer. h> More info
zinclude <ESPaDNS.h>
. PN, AqualaboSensor by Andres Sabas, based in the work of Libelium
const chark ssid = "songhuinobile”; Aqualabo Sensors. Aqualabo Sensars communication with Modbus slaves over RS232/485 (via RTU protocal). Requires an RS232/485 transceiver.
c char+ passvord = "13918134855"; More info
#ifdef  AVS_CLOUD_ENABLE
DFRobot_RTU by Arya DFRobot
Modbus RTU library for Arduino. A library to use an Arduino as master to control 2nd communicate via modbus protocol.
More info
#define CUST_SSID “songhuimobile” -
fine CUST_ROUTER_PASS "13918134855"
fine CUST_BROKER “awwisOu7xuagf.ats. iot.crn—north-1.anaz Close
fine CUST_CLOUD_CLIENT_ID "1234"
fine CUST_MQTTPUBLISHTOPIC "arduino_n100”
char HOST_ADDRESS[J=CUST_BROKER;
char CLIENT_ID[]= CUST_CLOUD_CLIENT_ID; v

Mz (WiF i

Program burning

. Programming via Arduino

1> Hardware connection
USR-M100-ARD*1

USB to TTL converter *1
Wi-Fi antenna*1

The hardware connection is like this:

PUSR’ pusr.com
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2> Downloading parameters settings
Tools-->Board--> “ESP32-WROOM-DA Module”

Tools-->Board-->Port-->Select the right COM

File Edit Sketch

Help

Auto Format Ctrl+T
Archive Sketch

Fix Encoding & Reload

Serial Monitor Crrl+shifteM
Serial Plotter Cerl+shift+L

0911m100ckv1

WiFi101 Firmware Updater
11010111111,

N
Arduino Yan Mini

efine PEYTEST ~ Flash Mode: "QI0° i i
define TEBser Flash Size: "4MB (32Mb)" ﬁﬁ::g:;dusmal o
=define NODBUST  Events Run On: "Core 1" Arduino Uno WiFi
=define FEEDDO Partition Scheme: "Default 4MB with spiffs (1.2MB APP/1.5MB SPIFFS)" Eo
#define AVS_CLI Erase All Flash Before Sketch Upload: "Disabled" ESP3252 Dev Module
Arduino Runs On: "Core 1" ESP32C3 Dev Module
Flash Frequency: "80MHz" ESP3252 Dev Module
CPU Frequency: "240MHz (WiFi/BT)" 2
Upload Speed: "921600" ESP3

Finclude <WiFil core Debug Level: "None" Tover Modute

#include <WiFiQ Port

ESP32 PICO-D4
nelude <TebS( Got goard Info ESP32-53-Box
Zinclude <ESPal ESP32-53-USB-0TG
Programmer: "AVRISP mkil* —
ESP3253 CAM LCD

const chark ssi Burn Bootloader
const char¥ password = "13918134855";

ESP3252 Native USB

ESP32 Wrover Kit (all versions)
UM TinyPICO

UM Feathers2

UM FeatherS2 Neo

=ifdef  AWS_CLOUD_ENABLE
#include <AWS_IOT. h>

UM TinyS2
#define CUST_SSID "songhuimebile” )
. . . UM RMP
=define CUST_ROUTER_PASS “13918134855 N
. P . . UM TinyS3
2define CUST_BROKER “awwisOu7suagf.ats. iot. cmnorth-1. anazonaws. con. cn
N o UM PROS3
=define CUST_CLOUD_CLIENT_ID "1234
. o . UM Feathers3
#define CUST_NQTTPUBLISHTOPIC “arduino_s100
S.0DI Ultra vi

char HOST_ADDRESS[)=CUST_BROKER;

LilyGo T-Display-S3
char CLIENT_ID[J= CUST_CLOUD_CLIENT_ID; IUE® FRERLT

micra<
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File Edit Sketch Tools Help

Auto Format Ctrl+T
Archive Sketch
0911m1000kv1 Fix Encoding & Reload

Serial Monitor Ctrl+Shift+M e
Serial Plotter Ctrl+Shift+L

Finelude <ViFi wWiFi101 Firmware Updater
sinclude <ViFig
#include <Webs{ Board: "ESP32-WROOM-DA Module"
zinclude <Espal  Flash Mode: "QIO”

Flash Size: "4MB (32Mb)"
har# ssii  Events Run On: "Core 1"
char# pas  Partition Scheme: "Default 4MB with spiffs (1.2MB APP/1.5MB SPIFFS)"

Erase All Flash Before Sketch Upload: "Disabled”
sifdef  AWS_CL| Arduino Runs On: "Core 1"
sinclude <ATS_I  Flash Frequency: "80MHz"
CPU Frequency: "240MHz (WiFi/BT)"

ine CUST_SS  ypload Speed: "921600"
CUST R Core Debug Level: "None"

CUST_BR, Port "COM17" Serial ports
CUSTLL " Get Board Info | G
ine CUST_HQ

char HOST_ADDRE Programmer: "AVRISP mkiI" >
char CLIENT_ID]| Burn Bootloader

cons

>
>
>
>
>
>
>
>
>
>
>
)

e er=- DUINT 1\

3> Users could edit, compile, and download code on the Arduino IDE.
Click the “Upload” button to compile the code first, When the compilation is about to be completed, press
and hold the reload button, power on the USR-M100-ARD. Do not release the reload button during the program

download process, otherwise the program will fail to be burned.

File Edit Sketch Tools Help
0911m100ckv!

#include <ViFi.h>
FiClient.h>»
#include <VebServer.h>
#include <ESPaDNS.h>

#ineluc

const chart ssid = “songhuimobile”;
const chark password = "13918134855";

#ifdef  AWS_CLOUD_ENABLE
#include <AVS_IOT.h>

ine CUST_SSID “songhuimobile”
ine CUST_ROUTER_PASS “13918134855"

s.iot. cn-north-1. anazonaws. com. cn”

ine CUST_CLOUD_CLIENT_ID "1234"
#define CUST_MQTTPUBLISHTOPIC ~arduine m100
char HOST_ADDRESS[]=CUST_BROKER;

char CLIENT_ID[]= CUST_CLOUD_CLIENT_ID;

3.2. Programming via ESP32 download tool

1> Users can edit code on Arduino IDE, and export compiled binary file.

PUSR’ pusr.com
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& 0911m1000kv1 | Arduino 1.8.5

File Edif sketch|Tools Help

Verify/Compile crl+R )
Upload Ctrl+U
0911m  Upload Using Programmer Ctrl+Shift+U

Export compiled Binary  CUI=ATE+S

Show Sketch Folder Ctrl+K
“includsnclude Library >
Fineluds g ile.,

#include <
#include <ESPmDNS.h>

VEDSEIVer. >
const char# ssid = "songhuimobile;
const char# password = "13918134853";

#ifdef  AVS_CLOUD_ENABLE
#include <AWS_IOT. h>

#define CUST_SSID “songhuimobile”
e CUST_ROUTER_PASS “13918134855"

char HOST_ADDRESS[]=CUST_BROKER;
char CLIENT_ID[]= CUST_CLOUD_CLIENT_ID;

< >

2> Open flash_download_tool, Chipset—ESP32

&

ChipType: ~ ESP32
WorkMode: |Develop

LoadMode: | WART

= |

3> Load .bin file

XXX.ino.bin Start register address: 0x10000
xxx.ino.bootloader.bin Start register address: 0x1000
XXX.ino.partitions.bin Start register address: 0x8000

Select COM port, BAUD is 921600.

SPIFlashConfig: 40MHz, DIO, DoNotChgBin

PUSR’ pusr.com
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SPIDownload

.y

| |86

Oo0o0o0geAaX™

5 5 9 9 9 "B B B

SPIFlashConfig

SPI SPEED SPI MODE . Detectedinfo
£ DoNotChgBin lash vendor:
(®) 40MHz Qalo .
- BEh : ZB
LockSettings
0267MHz O QouT lash devID:
CombineBin 4016h
O20Mtz - (|@pio louAD;amB
O 80MHz QDpout Default krystal:
40 Mh:
(O FASTRD ‘
3.
DownloadPanel 1
SYNC
2.
[ OoM:
START sTOP I ERASE i ‘COM-IS z
AUD: 921600 v

4> Power off the USR-M100-ARD, hold on the reload button, power on the USR-M100-ARD device, click

“START” button, it starts to programming.

W ESP32 FLASH DOWNLOAD TOOL V3.9.5

SPIDownload |

1

[ Y SN

2 999 8 B 9 89

SPIFlashConfig
SPI SPEED  SPI MODE
®@40MHz  OaQlo
0O267MHz O QouT
O20MHz @DIO
OsomHz O pouT
OFASTRD

DownloadPanel 1

[¥] DoNotChgBin
LockSettings
CombineBin
Default

Detectedinfo
flash vendor:
SEh: ZB
flash deviD:
4016h

1 QUAD;4MB

crystal:
40 Mhz

/

SYNC

/

START STOP

ERASE

5> Finished the programming.

o cPUSR’
e
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W ESP32 FLASH DOWNLOAD TOOL V3.8.5 — O X
SPIDownload !
A
s o G
- @ [B¥10000
s - o o0
O - |@
O -|@®
(| - @
0 o [
D - @ W
SPIFlashConfig
SPI SPEED SPI MODE Detectedinfo
e Oaio [ DoNotChgBin flash vendor:
z .
LockSettings 5Eh : ZB
0267MHz O QOUT flash deviD:
CombineBin 4016h
O 20MHz @®DIO QUAD:AMB
O80MHz O DOUT Default crystal:
40 Mh
O FASTRD -
DownloadPanel 1
1YL B| AP: AOB765FDBDF9 STA: AOB765FDBDFS
BT: AOB765FD8DFA ETHERNET: AOB765FDBDFB
SRk
COM: ~
START STOP ERASE ‘ COMTS |
BAUD: 921600 v

4. Functional Test

Note: All tests in this section are based on code provided by PUSR.
1> Preparatory Work
» Download the Modbus Slave tool and MQTTfx tool first.

» Find a router, change the SSID to “usriot” , and change the password to “0123456789" .

USR'GS1 6 Status Mode: Master

SSID: usriot

BSSID: D4:AD:20:67:FC:17
Channel: 11 (2.462 GHz)
Status Tx-Power: 20 dBm

Services

WAN

Hide SSID O

LAN
SSID usriot
Cellular Network
i Encryption mixed-psk v
Network Switch
Wireless I Key 0123456789 | &
B HW Mode 1ing ~

@ If STA is enabled, the configuration is affected by STA.

R

2> Power on the USR-M100-ARD device. If the work indicator is blinking, the Wi-Fi connection is successful.
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3> Connect the USB to TTL to USB port, open the Uart Assistant tool, users can check the IP address.

Note: After connecting the USB to TTL, the work indicator is steady on.

Uart Assistant

~COM Cﬁnfigrsrm - | Data |og] UartAssist V5.0.2 <3 L%
Channel [COM17 HL ~

Baudrelel1 15200 ~ I

Pariluhilsm [2023-09-27 19:58:03.885]% RECY ASCII>
[loop_line_395]->hornbill. publish: slave deviceid—>42 success

Databits IB v |

Stopbits m [2023-09-27 19:68:07. 408]# RECY ASCII>

Flowctrd |”|]”E 'I ARDUTHO ESP3? ————

@ Close | WEBserverSANFLE_ENAELE BEGIN

~

web server IP address:  http://192.168.1. 142

~Recv Options— 1
& ASCI HEX | | ARDUIND ESF32
¥ Log Display Mode < WEBserverSAMPLE_ENAELE END
[~ Auto Linefeed
[~ Hide Received Data

[~ Save RecvtoFile... ARDUTHO ESP32
AutoScroll Clear FHITESTSAMPLE_ENABLE BEGIN
Send Opti
enarpions [2023-09-27 19:58:08. 402]# RECV ASCII>
@ ASCI  HEX [loop_line_395]->hornbill. publish: slave deviceid—>42 success
[V UseEscape Chars® | | v

[~ Auto Append Bytes

] DataSendll.DCDl 2 RXD® 3. TXD@® 4 DTR# 5.GND# 6.0SR® & Clear 4 Cear
[~ Send from File ...

[~ Cycle [50000 s at+ver ot
en
Shortcut History
|& Ready! 2329/0 Ri<:884360 TX0 Reset | Yy

4> Connect the PC to the same router with the USR-M100-ARD device, and enter 192.168.1.142 on browser
url blank. The IP address should be the one of USR-M100-ARD.
Click OUT1_ON button, the DOT1 indicator will turn on.

Click OUT1_OFF button, the DOT1 indicator will turn off.

< C A FZ% | 192.168.1.142fro0t ONBUTTON A % M = @ % E &

M100: set DOUT

[[OUT1_ON | [ OUT1_OFF |[ OUT2_ON | [ OUT_20FF | geficurrent

5> Connect the Ethernet port to the LAN port of a router, the following information will be displayed on Uart
Assistant tool. Via this IP address(192.168.1.145), users can access the built-in webpage to control the IO

indicator also.
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Uart Assistant
~COM Configs 1 Datalog UartAssist ¥5.0.2 <@ L%
Channel |COM17 HL
"~

Baudrate|11520'3 '| ARDVINOD ESP32 ———————

Paitybits | NONE - I WEBserverSAMPLE_ENAELE END

D atabits I8 "|

Stopbits I‘I s |

[ﬁ ARDUTHO ESF32
Flowetd |NONE 7| | JpyyTRSTSANPLE_EWABLE BEGIN

i

@ Close
[2023-09-27 20:04:57.339]# RECV ASCII>
Recy Options [loop_line_395]—>hornbill publish: slave_ deviceid-»42 success

o ASCI ¢ HEX i
v Loa Displau Mod [2023-09-27 20:04:59. 267]% RECY ASCII>
W LogDisplay Mode K [cace SRTIITHN FVFHT ETH COMHECTED]

I Auto Linefeed E ETH Conmected
[” Hide Received Data || |case: ARDUINO_EVENT ETH_GOT_IF:
[~ Save RecvtoFile... ETH MAC: AQ:B7:65:FD:8D:FEAD:B7:65:FD:8D:FB

sutoSoroll Clear IPvd: localip:192. 168. 1. 145, FULL_DWPLEX, 100Mbp=

' . 20Z3-09=27 2000409, 540§ RECY aSCIT>
. Send Options L ! ]

[loop_line_388]—>hornbill. publish failed
+ ASCIl ¢ HEX
W Use Escape Chars(® | v
[ Aut nd B
. Od?pperb ptes DalaSendl 1.0CD#® 2 RXD@® 3.TX0@ 4. DTR® 5. GHD# 6.0SR4 § Clear 4 Clear
end from File ...
[ Cycle[50000 ms | |2 cond
en
Shortcut History
1€ Ready! 313070 Rx:920720 TX0 Reset | y
€ C  ases (e ] P T -~ -

M100: set DOUT

| OUT1_ON || OUT1_OFF || OUT2_ON || OUT_20FF || geticurrent

6> RS485 and AWS test
> Open MQTTfx.exe
Broker Address: awwis@u7xuagf.ats.iot.cn-north-1.amazonaws.com.cn
Broker Port: 8883
Client ID: Generate

SSL/TLS: Load the certificates, check the PEM Formatted

PUSR’ pusr.com
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[® Edit Connection Profiles

M2M Eclipse . .
MQTT-Test Connection Profile

Profile Name | MQTT-Test

Broker Address | awwisOu7xuagf.ats.iot.cn-north-1.an

Broker Port | 8883

Client ID | 6b172842d19f491792cb1234280f54 | Generate

General User Credentialsl SSIFAIES Proxy Last Will and Testament
Protocol TLSv1.2 -

CA signed server certificate
CA certificate file
CA certificate keystore

® Self signed certificates

CAFile D:\SEE\123\cal.pem
Client Certificate File  D:\$EE\123\67d7ec097c-certificate.pem.crt
Client Key File = DA\SEEN\123\67d7ec097c-private.pem.key

Client Key Password

PEM Formatted /

Self signed certificates in keystores

+ - Revert oK  App

> Click "Connect” button to connect the AWS server, subscribe to the “Arduino_m100” topic.

E MQTT.fx - 1.3.1

File Extras Help

‘ Disconnect a0

Publish Scripts  Broker Status  Log

arduino_m100 - Qos1 qos2 (EEEEEED <~
arduino_m100 2 | arduino_m100 1
Dump Mess...  M...
arduino_m100 2]
arduine m100 3
arduino m100 3

QoS0 27-09-2023 20:17:57.730...

deviceid4?| [0]->-1

[ Plain™ L Hex Base64

» Connect the PC and USR-M100-ARD device via USB to RS485, open Modbus Slave tool, set the

Slave ID to 42, and set the address to 31000.
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23 Modbus Slave - Mbslave1 — O .
File Edit Connection I Setup |Disp|ay View Window Help
DEEE 5| - aT% ¥

Mbslavel
ID=42:F=03 Slave Definition
No connection

A 42
Alizs TITIT [SlavelD ] [ o ] ~
Function ‘03 Haolding Register (4x) V‘

0
Quantity:
View
Fiows

@10 O Os0 O100  OFitto Quantiyy

DHlde Alias Columns DPLCAddvesaes(Eﬁael)

Error Simulation

[ skip response [insert CRGLRC error
(Notwhen using TCRAF) v

D (el eI Dty [[IRetum exception 06, Busy:

W o | ~N|o v & w | =
o o o o o o o o o

For Help, press F1. Port 15: 115200-8-N-1

> Serial settings, distinguish the R5485 COM from the Download COM.

¥ Modbus Slave - Mbslave1 - O X

File EdithonnEctioFl Setup Display View Window Help
DEHAEC|=2a 2N

Mbeee Connection Setup E@
Connection
‘Ser\alPurt V‘
Cancel

Serial Settings

h I |USE-SERIAL CH340 (COM15) "H
115200 Baud Made

@RTU O AsCl
‘EDatab\ts ~
i Flow Contral

NonePaity  ~| [JosR [JCTs [ZRTS Toggle

1 Stop Bit [ms] RTS disable delay
op B ~

TCR{IP Server
IP Address Port
127001

Any Address
Ignare Unit ID

For Help, press F1. Port 17: 115200-8-N-1

» Change the value of register to 77, and the changed data can be received by the MQTTfx. It

means the device connect to AWS and can communicate with the RS485 device.
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[ZIEW Extras Help

File Edit Connection Setup Display

DELS | O "\5 ‘ T ‘ Disconnect
Mbslavel
ID=42:F =03 Publish Scripts  Broker Status Log

Alias 31000 arduino_m100 -
j‘ arduino m100 405 | arduino m100
Dump Mess... M. (LETET arduine m100
arduino_m100
arduino_m100
arduino_m100

arduino_m100

oo |N|o|vn|[s|lw[v][= o

o o ol oo o o o o

23 Modbus Slave - Mbslave

(" Autoscroll ] S
400

401
402
403
404

405

arduino_m100

QoS0 27-09-2023 20:34:59.740...

deviceidd2| [0]1->77

5. Contact Us

Jinan USR 10T Technology Limited

405

Address : Floor 12 and 13, CEIBS Alumni Industrial Building, No. 3 Road of Maolingshan, Lixia District, Jinan,

Shandong, China

Official website: https://www.pusr.com
Official shop: https://shop.usriot.com
Technical support: http://h.usriot.com/
Email : sales@usriot.com

Tel : +86-531-88826739

Fax : +86-531-88826739-808

6. Disclaimer

The information in this document provided in connection with Jinan USR 10T technology ltd. and/or its affiliates’

products. No license, express or implied, by estoppel or otherwise, to any intellectual property right is granted by

this document or in connection with the sale of USR loT products. EXCEPT AS SET FORTH IN THE TERMS AND

CONDITIONS AS SPECIFIED IN THE LICENSE AGREEMENT FOR THIS PRODUCT, USR IoT AND/OR ITS AFFILIATES

ASSUME NO LIABILITY WHATSOEVER AND DISCLAIMS ANY EXPRESS, IMPLIED OR STATUTORY WARRANTY RELATING

TO ITS PRODUCTS INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTY OF MERCHANTABILITY, FITNESS FOR A

PARTICULAR PURPOSE, OR NON-INFRINGEMENT. IN NO EVENT SHALL USR IoT AND/OR ITS AFFILIATES BE LIABLE

FOR ANY DIRECT, INDIRECT, CONSEQUENTIAL, PUNITIVE, SPECIAL OR INCIDENTAL DAMAGES (INCLUDING, WITHOUT

LIMITATION, DAMAGES FOR LOSS OF PROFITS, BUSINESS INTERRUPTION OR LOSS OF INFORMATION) ARISING OUT

PUSR’
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OF THE USE OR INABILITY TO USE THIS DOCUMENT, EVEN IF USR IoT AND/OR ITS AFFILIATES HAVE BEEN ADVISED OF
THE POSSIBILITY OF SUCH DAMAGES. USR IoT and/or its affiliates make no representations or warranties with
respect to the accuracy or completeness of the contents of this document and reserves the right to make changes
to specifications and product descriptions at any time without notice. USR loT and/or its affiliates do not make

any commitment to update the information contained in this document.
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Your Trustworthy Smart 10T Partner
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Official Website:
Official Shop:
Technical Support:

Inquiry Email: inquiry@usriot.com

Skype & WhatsApp: +86 13405313834 XEEAREARS BREWRETS

Click to view more: &
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